DELL 3-2-1 REFERENCE CONFIGURATIONS: HIGH-AVAILABILITY VIRTUALIZATION WITH DELL POWEREDGE R720 SERVERS

A Principled Technologies configuration guide commissioned by Dell Inc.
**TABLE OF CONTENTS**

Table of contents ........................................................................................................ 2

Introduction .................................................................................................................. 4
  Why 3-2-1? ................................................................................................................. 4
  Features of the new Dell PowerEdge R720 ......................................................... 5
  About the Intel Xeon processor E5 family ......................................................... 6
  About VMware vSphere 5 ......................................................................................... 6
  About Dell Management Plug-In for VMware vCenter ........................................... 6
  About Microsoft SQL Server 2008 R2 ................................................................. 7
  About Microsoft Exchange Server 2010 SP2 .................................................... 7
  About Microsoft SharePoint Server 2010 ............................................................ 7

We show you how—Setting up your Dell 3-2-1 Reference Configuration .... 7
  Cabling ...................................................................................................................... 8
  Configuring the management server ................................................................. 10
  Setting up the switches ....................................................................................... 10
  Setting up the storage ......................................................................................... 11
  Configuring the ESXi host servers .................................................................... 12
  Creating and configuring a cluster in vCenter Server ..................................... 13
  Configuring the storage ...................................................................................... 13
  Configuring the networking ................................................................................ 13
  Configuring the Dell Management vCenter plug-in ........................................... 14
  Creating the virtual machines .......................................................................... 15
  Configuring the virtual machines ..................................................................... 16

Summing it all up ........................................................................................................ 24

Appendix A - Configuring the management server ............................................. 25
  Setting up vCenter Server .................................................................................. 25

Appendix B - Setting up the switches and storage ............................................... 26
  Creating a VLAN and assigning ports on the Dell PowerConnect 6224 switch .......................................................................................... 26
  Saving the Dell PowerConnect 6224 switch configuration ............................ 26
  Setting up the Dell EqualLogic PS6100XV storage .......................................... 26

Appendix C - Configuring the ESXi host servers ............................................... 28
  Configuring vSphere 5 (ESXi) after installation ............................................. 28
  Installing the Dell EqualLogic Multipathing Extension Module (MEM) version 1.1 Beta on the ESXi servers .......................................................... 28

Appendix D - Creating and configuring a cluster ............................................... 29
  Installing vSphere Client ..................................................................................... 29
  Creating a cluster using the vSphere Client ..................................................... 29

Appendix E - Configuring the storage ................................................................. 30
INTRODUCTION

Choosing the right combination of hardware and software for your data center can be a daunting task. You need powerful servers to run your applications in virtual machines, reliable storage to safely store your data, and software to help you manage your infrastructure. Because your applications must run with little to no downtime, your infrastructure requires several components, some redundant, to maintain high availability: at least two virtual machine host servers, a management server, storage, and switches to put the pieces together. Is there a simple and foolproof way to ensure you get the best hardware and software that all works together for your data center?

Dell™ 3-2-1 Reference Configurations take the guesswork out of designing, ordering, and deploying your virtualized infrastructure in your data center. Dell has designed proven, tested architecture to help you deploy a solution that meets your needs. In this guide, we discuss the different pieces that comprise a Dell 3-2-1 Reference Configuration, the benefits they bring to your organization, and how to deploy your new solution using best practice recommendations and guidelines from Dell.

For the results of our performance tests for this solution, see our companion performance report, where we found that the solution could support 1,000 users with room for future growth, at http://www.principledtechnologies.com/clients/reports/Dell/R720_321_performance.pdf.

Why 3-2-1?

Dell 3-2-1 Reference Configurations consist of three servers, two switches, and one storage array. This type of configuration allows you to keep your infrastructure up and running, even in the face of hardware failure, so you have very little downtime and can keep your business running smoothly.

In this guide, we focus on a 3-2-1 Reference configuration built on the latest Dell PowerEdge® R720 servers, powered by new Intel® Xeon® processors E5-2680. Two of these servers can host your VMware® vSphere™ 5 virtual machines (VMs) and run all of your critical business applications, while giving you failover protection. Our example servers hosted VMs running three common business-critical applications from Microsoft®: SQL Server® 2008 R2, Exchange Server 2010 SP2, and SharePoint Server® 2010. To learn more about the Dell PowerEdge R720 and the benefits it brings to your business, please see the Features of the new Dell PowerEdge R720 section below. The third server in this configuration, a Dell PowerEdge R620, ran as a management server.
Two Dell PowerConnect™ 6224 switches allow stacking to provide interconnectivity and ample bandwidth for any network traffic, isolate different types of network traffic via VLANs, and maintain high availability in the event of a switch failure.

The Dell EqualLogic™ PS6100XV storage array rounds out the 3-2-1 Reference Configuration, with excellent I/O performance, optimized scalability, and flexible management options to meet all your storage and performance needs.

Features of the new Dell PowerEdge R720

![Figure 1: The new Dell PowerEdge R720 server, powered by the Intel Xeon processor E5-2680.](image)

The new Intel Xeon processor E5-2680-powered Dell PowerEdge R720 2U rack server incorporates many improvements and features designed to improve performance, lower power consumption, and make maintenance easier. Some of these features include the following:

**Performance.** Dell engineered the PowerEdge R720 to handle complex workloads, with I/O and internal data management technologies (i.e., NSC, NPAR, CacheCade) to allow faster access to information and GPU accelerators to solve challenges faster than ever.

**Processors.** The Dell PowerEdge R720 is powered by two Intel Xeon processors E5-2680, which incorporate the very latest in processor technology from Intel. The powerful processors provide exceptional performance and make the PowerEdge R720 a powerful virtualization platform.

**Power efficiency.** Dell PowerEdge R720 servers implement leading industry power efficiency standards, and are designed to optimize performance while maintaining low power consumption. Automated tracking and regulation of thermal activity, intelligent design of right-sized power options, and high efficiency fans and airflow management work to save power, saving you money in the process.

**Management.** The Dell PowerEdge R720, like all late-model Dell servers, comes with the Dell Lifecycle Controller. This tool simplifies server management by providing a single
interface for management functions and by storing critical system information in the system itself. There are no CDs or USB keys to keep track of for drivers or firmware.

**Storage.** With impressive storage capacity for small business servers, the Dell PowerEdge R720 is available in both an 8-bay and 16-bay chassis.

**Memory.** The Dell PowerEdge R720 holds up to 768 GB of RAM, many times the RAM capacity of older small business servers, allowing for powerful flexibility with virtualized database solutions.

**About the Intel Xeon processor E5 family**

The new Intel Xeon processor E5 family, which comes standard in new Dell PowerEdge servers, incorporates new technology and features to meet the computing demands of the present and future. The Intel Xeon processor E5 family delivers intelligent and adaptive performance using such features as Intel Turbo Boost Technology 2.0, Intel Advanced Vector Extension, Intel Integrated I/O, and Intel Data Direct I/O Technology. These new processors also feature Intel Trusted Execution Technology (Intel TXT) and utilize Intel Advanced Encryption Standard New Instructions (Intel AES-NI) to help keep your data safe.

For more information about the Intel Xeon processor E5 family, including the Intel Xeon processor E5-2680, visit [http://www.intel.com](http://www.intel.com).

**About VMware vSphere 5**

vSphere 5 is the latest virtualization operating system from VMware. vSphere 5 virtualizes server, storage, and networking resources, achieving a consolidation ratio greater than 15:1. Features such as automated management and dynamic resource allocation improve efficiency. The services that vSphere 5 provides fall into two categories: Infrastructure services or application services. The former handle the virtualization of resources and their allocation to application when most needed, while the latter provide service-level controls to applications running on vSphere 5.

To learn more about VMware vSphere 5, visit [http://www.vmware.com/products/vsphere/overview.html](http://www.vmware.com/products/vsphere/overview.html).

**About the Dell Management Plug-In for VMware vCenter**

The Dell Management Plug-In for VMware vCenter simplifies many tasks IT administrators need to perform on a routine basis, such as discovering, monitoring, managing, patching, and deploying ESXi to Dell servers without the need of an agent running on the servers. Using Dell Management Plug-In for VMware vCenter,
administrators can also monitor networking and storage. The Dell Management Plug-In for VMware vCenter allows administrators to easily view the status of multiple ESXi servers and fully manage them from within the vCenter console. The plug-in, developed as part of the Dell OpenManage collection of software, is easily deployed into an existing vCenter Server.

### About Microsoft SQL Server 2008 R2

SQL Server 2008 R2 is the latest release of Microsoft’s database management platform. As with each release, Microsoft has added new features to expand on the capabilities of their Database Management System (DBMS) platform. Where earlier versions of SQL Server required database administrators to rely primarily on either in-house applications or third-party tools to monitor multiple instances, SQL Server 2008 R2 simplifies multi-server management.

### About Microsoft Exchange Server 2010 SP2

Microsoft Exchange Server 2010 SP2 equips you with a robust communications platform that can also give your users anywhere access, increasing their mobility. Some other key features of Exchange Server 2010 include Unified Mailbox Resiliency, archiving, and access to the Outlook Web Application.

### About Microsoft SharePoint Server 2010

Microsoft SharePoint Server 2010 is the latest version of this very popular and flexible software. It allows users to create collaborative Web sites and to create and manage their own workspaces. Some of its key features include SharePoint 2010 Communities, which lets users share ideas and information from a single platform; the SharePoint Search feature, which lets users find other people and information quickly; and SharePoint 2010 Insights, which gives users an improved ability to access databases, reports, and business applications.

WE SHOW YOU HOW—SETTING UP YOUR DELL 3-2-1 REFERENCE CONFIGURATION

For this guide, we assume that you have an existing infrastructure server running Active Directory Domain Services (AD DS), Domain Name Services (DNS), and Active Directory Certificate Services.

Figure 2 shows the hardware that comprises the Dell 3-2-1 Reference Configuration we tested, along with the function of each piece.
Our Dell 3-2-1 Reference Configuration had the following software requirements:

- VMware vSphere ESXi 5
- VMware vCenter 5
- VMware vSphere Client 5
- Dell Management Plug-In for VMware vCenter
- Microsoft SQL Server 2008 R2
- Microsoft Exchange Server 2010 SP2
- Microsoft SharePoint Server 2010

In each section that follows, we present an overview of the basic steps you’ll need to follow to set up your Dell 3-2-1 Reference Configuration. If you require more detailed instruction, follow the links at the end of each section to find step-by-step instructions in the appendices.

**Cabling**

Cable your hardware as appropriate. For our high-availability setup, we configured the network cabling of the hardware as shown in Figure 3.
To take advantage of the features of the Dell PowerConnect 6224 switches, we implemented the stacking feature to allow connectivity between the switches. This feature lets you easily manage the two switches from a single management console and allows for greater bandwidth than you would have using link aggregation.

Figure 4 shows how we configured the network cables across the NICs for each Dell PowerEdge R720.

<table>
<thead>
<tr>
<th>NIC</th>
<th>Port number</th>
<th>Traffic type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integrated on-board NIC</td>
<td>1</td>
<td>Management</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>vMotion</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>iSCSI #1</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Public/VM #1</td>
</tr>
<tr>
<td>Broadcom NetXtreme II 5709</td>
<td>1</td>
<td>iSCSI #2</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Public/VM #2</td>
</tr>
</tbody>
</table>

Figure 4: NIC port configurations for each Dell PowerEdge R720.

Once we connected all of the network cables, we attached all power cables. At this point, it was safe to power on all of the hardware.
Configuring the management server

Configure the Dell PowerEdge R620 as the management server. Before completing these steps, ensure that you have applied all available updates to Windows Server 2008 R2 SP1. Additionally, you will need to set the IP addresses of the NICs. Figure 5 shows how we set up the NICs.

<table>
<thead>
<tr>
<th>NIC</th>
<th>Traffic type</th>
<th>Adapters assigned to this subnet</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Service console</td>
<td>192.30.1.203</td>
</tr>
<tr>
<td>2</td>
<td>Service console</td>
<td>192.30.1.204</td>
</tr>
<tr>
<td>3</td>
<td>Management</td>
<td>192.168.1.203</td>
</tr>
<tr>
<td>4</td>
<td>Switch access</td>
<td>192.168.2.203</td>
</tr>
</tbody>
</table>

Figure 5: The IP addresses of the four NICs we used.

Next, install a standalone instance of VMware vCenter Server on the management server. For step-by-step instructions, see the Setting up vCenter Server section in Appendix A.

Setting up the switches

Complete the initial setup of the Dell PowerConnect 6224 switches. First, select an IP scheme for your Dell 3-2-1 Reference Configuration environment. Figure 6 shows the IP scheme we used, and also includes the subnet of the infrastructure switch, which for our testing purposes was 192.168.1.0.

<table>
<thead>
<tr>
<th>Subnet</th>
<th>Traffic type</th>
<th>Adapters assigned to this subnet</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.10.1.0</td>
<td>iSCSI</td>
<td>iSCSI adapters (for this setup, there are twelve)</td>
</tr>
<tr>
<td>192.20.1.0</td>
<td>vMotion</td>
<td>vMotion adapters (for this setup there are two)</td>
</tr>
<tr>
<td>192.30.1.0</td>
<td>Service console</td>
<td>Service console adapters (for this setup, there are four)</td>
</tr>
<tr>
<td>192.168.1.0</td>
<td>Public/VM</td>
<td>Storage management, VM network, infrastructure server, client machines, and iDRAC management</td>
</tr>
</tbody>
</table>

Figure 6: The IP scheme we used in our setup of the Dell 3-2-1 Reference Configuration.

By default, the Dell PowerConnect 6224 switches are configured with a blank password, have the IP address 192.168.2.1, and have the subnet mask 255.255.255.0. We used a serial connection to access the basic setup wizard on the switches, allowing us to easily configure an administrator password. For more information on configuring
Now, use the Dell PowerEdge R620 management server to access the Dell PowerConnect 6224 switches and create the VLANs to isolate the different types of traffic. Ensure that your switches are connected using the stacking modules to create the VLANs on both switches. To create the VLANs, perform the following steps on the Service console:

1. Connect the fourth NIC port on the PowerEdge R620 into an available port on the switch using an Ethernet cable. Select a port on the switch that you will not be adding into any VLAN to avoid losing connectivity into the switch management GUI when you assign ports to the appropriate VLANs.

2. Open a Web browser window, enter the IP address of the switches, and enter the appropriate administrator credentials when prompted.

3. Using the Web console, create two VLANs. Figure 7 shows the VLAN ID and type of traffic assigned to each VLAN.

4. Assign the appropriate ports on each switch unit to each VLAN.

5. Copy the running configuration to the startup configuration in the switch. This will save and subsequently reload the current switch configuration in the event of power loss of the switches.

   For step-by-step instructions on how to create a VLAN and assign ports to it or saving the running configuration, see the corresponding sections in Appendix B.

   We recommend that you follow Dell best practices for switch ports that handle iSCSI traffic. For more information, see the latest edition of the Dell EqualLogic Configuration Guide at http://www.delltechcenter.com/page/EqualLogic+Configuration+Guide.

### Setting up the storage

Now that you have created VLANs, begin initial setup of the storage. To complete the initial storage configuration on the Dell EqualLogic PS6100XV, complete the following steps:

<table>
<thead>
<tr>
<th>VLAN ID</th>
<th>Traffic type</th>
<th>Ports assigned to this VLAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>iSCSI</td>
<td>iSCSI traffic ports from storage and servers (for this setup, there are 12)</td>
</tr>
<tr>
<td>20</td>
<td>vMotion/Management</td>
<td>vMotion and service console ports (for this setup, there are six)</td>
</tr>
</tbody>
</table>

**Figure 7: Sample VLAN configuration.**
1. Using the command-line console, via serial cable, go through the initial configuration process for the Dell EqualLogic PS6100XV. Supply a group name, group IP address, and an IP address for the first port on the array.

2. Using a computer connected to the storage VLAN and on the same subnet as the group IP address, open a Web browser and enter the group IP address.

3. After providing the appropriate login credentials, use the Web interface to create a RAID 10 storage pool, and create eight volumes. Figure 8 shows the volumes we created and the sizes we allocated to each volume. The virtual machine volumes hold the VM operating system files, and the remaining volumes are for application data and log files.

<table>
<thead>
<tr>
<th>Volume name</th>
<th>Volume size (GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine1</td>
<td>70</td>
</tr>
<tr>
<td>VirtualMachine2</td>
<td>70</td>
</tr>
<tr>
<td>VirtualMachine3</td>
<td>70</td>
</tr>
<tr>
<td>SharePoint</td>
<td>250</td>
</tr>
<tr>
<td>Exchange</td>
<td>500</td>
</tr>
<tr>
<td>ExchangeLog</td>
<td>100</td>
</tr>
<tr>
<td>SQLData</td>
<td>250</td>
</tr>
<tr>
<td>SQLLog</td>
<td>50</td>
</tr>
</tbody>
</table>

Figure 8: The volumes we created on the Dell EqualLogic PS6100XV.

4. Enable unrestricted access on all of the volumes. (Note that once VMware ESXi host servers configuration is complete, we will go back and restrict access to the ESXi host servers.)

For step-by-step instructions on setting up the storage, see Appendix B.

Configuring the ESXi host servers

Now, configure the Dell PowerEdge R720 servers, which will use VMware ESXi to create and host the virtual machines for running business applications.

To configure iDRAC access, reboot the server, press F2 to enter the BIOS and select iDRAC Settings from the menu. From there, you can configure your network settings as well as other options.

To configure ESXi on each of the hosts, complete the following steps on each of the two Dell PowerEdge R720s:

1. Configure management network settings by pressing F2 once ESXi has booted. For our testing, we set a static IP address to match our management IP scheme.

2. Set the root user password.

3. Using a file transfer utility, copy the Dell EqualLogic Multipathing Extension Module (MEM) .zip file, and install it from the .zip file. Verify that the MEM is functional on each server.
For step-by-step instructions on how to configure ESXi on the Dell PowerEdge R720 host servers, see Appendix C.

Creating and configuring a cluster in vCenter Server

To create the cluster on the Dell PowerEdge R620 management server, complete the following steps:

1. Install vSphere Client on the management server.
2. Using vSphere Client, connect to the vCenter Server using the appropriate credentials.
3. Log in, create a new datacenter, and create a cluster within the datacenter, enabling HA and EVC for Intel hosts.
4. Add both ESXi hosts to the cluster.

For more detailed instruction on how to complete each of these tasks, see Appendix D.

Configuring the storage

To configure the Dell EqualLogic PS6100XV storage, complete the following steps:

1. On the management server, use vSphere Client to access your cluster, and obtain the iSCSI name for each of the ESXi hosts.

Copying the iSCSI names of the ESXi hosts into a blank notepad document allows you to have these names readily available.

2. Open a Web browser and log into the management console for the Dell EqualLogic PS6100XV using the appropriate credentials. Go through each of the volumes, restrict access based on iSCSI initiator name, and add both ESXi hosts.

3. Once you have restricted access to the ESXi hosts, access the cluster in vSphere Client. Then, add each of the storage volumes as a new datastore, formatting them using the VMFS-5 file system (default) and using the maximum capacity for each volume.

For step-by-step instruction on how to complete each of these tasks, see Appendix E.

Configuring the networking

Now, configure the remaining networking for the virtual machines, which include the VM/public network, vMotion, and iSCSI. Log into vCenter Server through vSphere Client on the management server, and complete the following steps:
1. Configure VM networking so that the virtual machines can connect with the client machines in your existing infrastructure. Click on the first ESXi host, and in the Networking Configuration menu, create a vSphere standard switch, assign the host NICs that connect to your existing infrastructure or public network, and assign the appropriate network label and IP settings. Repeat this for the second ESXi host.

2. Configure the vMotion network. In the Networking Configuration menu, add a VMkernel, assign the designated vMotion host NIC, and apply a label. Be sure to check the box that allows the use of the port group for vMotion.

3. Apply the desired IP settings, and repeat for the second ESXi host.

4. Configure the iSCSI network. On both ESXi hosts, complete the following steps:
   a. In the Networking Configuration menu, create an additional VMkernel and vSphere standard switch, and assign the first host NIC designated for iSCSI traffic. Repeat for the second host NIC for iSCSI traffic.
   b. Add the iSCSI storage adapter and add each VMkernel adapter to the VMkernel port bindings list. Rescan the host bus adapter to ensure all volumes are available.
   c. Go into each vSwitch and set the MTU to 9,000 to enable jumbo frames on each of the iSCSI NICs.
   d. In the iSCSI storage adapter, enter the group IP address of the Dell EqualLogic storage into Dynamic discovery, and rescan the HBA when prompted.

For step-by-step instruction on how to complete each of these tasks, see Appendix F.

Configuring the Dell Management vCenter plug-in

To configure the Dell Management Plug-In for VMware vCenter, complete the following steps:

1. The Dell Management Plug-In for VMware vCenter is available at http://content.dell.com/us/en/enterprise/d/virtualization/management-plug-in-for-vmware-vcenter as a free self-extracting executable for one server. After you extract the OVF Template, you can deploy it easily by selecting Deploy OVF Template from the File menu option, and starting it as you would any VM created in vCenter Server.

2. Register the appliance in vCenter by browsing to the URL established during deployment.

3. Create a connection profile that contains the iDRAC credentials and the host credentials of the ESXi host or hosts you wish to manage. OpenManage will
automatically run an inventory after you create the connection profile, and will regularly update that inventory from that point. For detailed instruction for completing these tasks, see Appendix G.

Creating the virtual machines

To create the VMs, install the operating system on each, and append the additional storage volumes to each, complete the following steps:

1. Using vSphere Client, log into vCenter Server on the management server, and select one of the ESXi hosts in the cluster. Create three new virtual machines using the following options:
   a. Choose to store the VM files on one of the three OS datastores. You will use a datastore for each VM OS.
   b. Select Microsoft Windows Server 2008 R2 as the operating system.
   c. Add one vmxnet3 NIC.
   d. Allow the OS virtual size to use the maximum capacity of the datastore.
   e. Select Edit the virtual machine settings before completion, and set the appropriate number of virtual processors and RAM.
   f. Add a VMware Paravirtual iSCSI controller.

2. Attach the Windows Server 2008 R2 installation DVD to each of the VMs and complete the OS installation process. Perform the following steps for each:
   a. Install the latest available VMware Tools.
   b. Assign a static IP address to the NIC.
   c. Run Windows Update and apply all the latest available updates to the VM.

3. Attach the additional storage volumes to each VM. To do this, complete the following steps:
   a. Right-click and go into the Edit Settings section of the VM and add a hard disk, then select the appropriate datastore and modify the size of the virtual hard disk to fit the maximum capacity of the datastore. Figure 9 shows the datastores assigned to each VM.
   b. Log into the VM using the console and add the volume in Windows storage management.
<table>
<thead>
<tr>
<th>VM assignment</th>
<th>Datastore</th>
<th>Volume size (GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VM #1</td>
<td>VirtualMachine1</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>SQLData</td>
<td>250</td>
</tr>
<tr>
<td></td>
<td>SQLLog</td>
<td>50</td>
</tr>
<tr>
<td>VM #2</td>
<td>VirtualMachine2</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>Exchange</td>
<td>500</td>
</tr>
<tr>
<td></td>
<td>ExchangeLog</td>
<td>100</td>
</tr>
<tr>
<td>VM #3</td>
<td>VirtualMachine3</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>SharePoint</td>
<td>250</td>
</tr>
</tbody>
</table>

*Figure 9: The volumes we assigned to each VM.*

For detailed instruction on completing each of these tasks, see Appendix H.

**Configuring the virtual machines**

**Installing Microsoft SQL Server 2008 R2 on VM #1**

After creating the virtual machines, install Microsoft SQL Server 2008 R2 on VM #1. Although it is not required, you should, when possible, deploy SQL Server 2008 R2 on machines that are part of an Active Directory® domain. If you do choose to deploy SQL Server in a domain, do not make the SQL Server service domain accounts members of the Domain Administrators group. Grant only the necessary rights on the local server to the SQL Server service account as part of your pre-installation planning. The SQL Server installation software creates the local groups it needs for its security purposes.

To install SQL Server 2008 R2, complete the following steps:

1. Insert the SQL Server 2008 R2 DVD into the host machine DVD drive, mount it to the virtual machine, and log into the virtual machine. If prompted to enable the .NET Framework Core role, click OK.
2. On the Installation Center screens, choose Installation, and choose to proceed with a new installation. (See Figure 10.)
3. Proceed through the first several installation steps, entering license information, and installing prerequisites with default options specified. On the Setup Role screen, choose a SQL Server Feature Installation.

4. On the Feature Selection screen, select only what you need for your particular configuration (see Figure 11). We chose the following features:
   - Database Engine Services
   - Full-Text Search
   - Client Tools Connectivity
   - Client Tools Backwards Compatibility
   - Basic and Complete Management Tools.
5. On the first installation, choose to install the default instance. If you perform subsequent installations on the same server, choose named instance and provide a name for the instance.

6. Configure the credentials of the SQL Server service account and SQL Server Agent accounts.

7. Specify SQL Server administrators, and specify the authentication mode desired for your configuration. Microsoft recommends Windows Authentication mode, but legacy applications may require SQL Server authentication.

8. Complete the installation.

For step-by-step instruction on installing SQL Server 2008 R2 on VM #1, see Appendix I.

Installing Microsoft Exchange Server 2010 on VM #2

To install Microsoft Exchange Server 2010 on VM #2, complete the following steps:

1. Install the Web Server (IIS) role and necessary role services, .NET Framework, and the latest available Microsoft Filter Pack. Set the Net.Tcp Port Sharing Service to start automatically, and install the Remote Server Administration Tools pack. Reboot the server.
2. Insert the Exchange 2010 installation DVD, and capture the DVD drive to the virtual machine. When the Autoplay window appears, click Run Setup.EXE to access the main installation menu (see Figure 12).

![Figure 12: The main installation menu for Exchange Server 2010.](image)

3. The installer should consider steps 1 and 2 to be complete (they will appear grayed out). Click Step 3: Choose Exchange Language Option, and install only languages from the DVD.


5. On the introduction screen, click Next, and accept the license agreement.

6. Select Typical Exchange Server Installation, and click Next (see Figure 13).
7. Leave the organization name at default (First Organization), and click Next.

8. To enable compatibility with previous Outlook 2003 clients, at the question about client computers running Outlook 2003 or Entourage, select Yes, and click Next.

9. Click Next to accept defaults for Configure Client Access server external domain, and select your preference for the Customer Experience Improvement Program.

10. The installation will now perform a readiness check. (If a warning about a lack of SMTP appears after the check finishes, ignore it. We will address this later.) To start the installation process, click Install (see Figure 14).
11. Once the installation has completed, click Finish. Exchange should automatically open the Exchange Management Console (see Figure 15).
To receive external mail, you will need to contact your Internet service provider (ISP) to register your MX record associated with your mail server’s external IP address. You will also need to establish routes in your firewall to direct all SMTP traffic to your Exchange Server 2010 IP address.

**Installing SP2 for Microsoft Exchange Server 2010**


**Moving the location of a mailbox database**

The final step before your Exchange setup is ready to use is to move the mailbox databases and logs from their default location to the designated volumes. To move mailbox database, complete the following steps:

1. Open the Exchange Management Console and select the mailbox you wish to move within the Organization Configuration section.
2. Right-click the mailbox, click Move Databases, and enter the new paths of the database .edb file and the log files. You will be prompted to dismount and remount the databases for the action to complete before the move finishes.

For detailed instructions on completing each of these tasks, see Appendix I.

**Installing Microsoft SharePoint Server 2010 on VM #3**

To install Microsoft SharePoint Server 2010 on VM #3, complete the following steps:

1. Insert the installation DVD, and capture the DVD drive in the VM console. Launch setup.exe, and click Install software prerequisites (see Figure 16).

![SharePoint Server 2010 Installation Menu](image)

*Figure 16: The main installation menu for SharePoint Server 2010.*

2. When the prerequisites finish installing, click Install SharePoint Server on the main SharePoint installation menu.

3. Choose the Stand-alone server type, and click Install (see Figure 17).
4. When the installation finishes, check the box for Run the SharePoint Products Configuration Wizard now, and click Close.

5. When the configuration completes successfully, click Finish.

For detailed step-by-step instruction on how to complete each of these tasks, see Appendix I.

**SUMMING IT ALL UP**

Ensuring that your virtualized infrastructure is highly available, performs well, and keeps costs down is important. To keep your business running, you need a system that not only handles your business in an effective, structured manner, but one that won’t leave customers or employees frustrated with constant outages.

Dell 3-2-1 Reference Configurations, which include the latest Dell PowerEdge R720 servers and EqualLogic storage, provide you and your business with the tools to design and deploy a virtualization infrastructure with no hassles and continued support.

As this guide makes clear, Dell 3-2-1 Reference Configurations take the guesswork out of the typically complicated task of designing, setting up, and configuring a virtual infrastructure, and instead make the process simple and straightforward.
APPENDIX A - CONFIGURING THE MANAGEMENT SERVER

Setting up vCenter Server

1. Add the Service Console to the domain.
2. Insert the vCenter Server 5 DVD.
3. Select Autorun.
4. Select vCenter Server from the list of VMware Product Installers, and click Install.
5. Select English, and click OK. The installer will configure .NET Framework at this point.
6. Click Next.
7. Click Next to accept the End-User Patent Agreement.
8. Accept the License Agreement, and click Next.
9. Enter the User Name and Organization information, leave the License key field empty, and click Next.
10. Select Install a Microsoft SQL Server 2008 Express instance, and click Next.
11. Select Use SYSTEM Account, and click Next.
12. Click OK if an FQDN error message appears.
13. Accept the default destination folders, and click Next.
14. Select Create a standalone VMware Server instance, and click Next.
15. Accept the default ports, and click Next.
16. Accept the default ports for the inventory service, and click Next.
17. At the vCenter Server JVM Memory screen, select Small (less than 100 hosts of 1000 virtual machines), and click Next.
18. Click Install.
19. Click Finish when installation completes.
APPENDIX B - SETTING UP THE SWITCHES AND STORAGE

Creating a VLAN and assigning ports on the Dell PowerConnect 6224 switch

1. Open a Web browser and enter the IP address of the switch. Enter the appropriate login credentials.
2. In the left pane, expand Switching, VLAN, and click VLAN Membership.
3. In the right pane, click Add.
4. Enter the first VLAN ID and Name, and click Apply Changes.
5. Repeat Step 4 twice to create the remaining VLANs.
6. When you finish, click Back. The VLAN drop-down menu shows the newly created VLANs.
7. To add a port to a VLAN, select the appropriate VLAN from the drop-down menu, and click the desired ports in the Static row.
8. Click Apply Changes to save the VLAN port assignments.
9. Repeat steps 7 and 8 twice to complete the port assignments for the remaining two VLANs on Unit 1, click to select Unit 2 (the other switch), and repeat steps 7 and 8 for all VLANs.

Saving the Dell PowerConnect 6224 switch configuration

1. Open a browser, and log onto the Dell OpenManage Switch Administrator using the switch IP address.
2. In the tree view of the Switch Administrator, expand the File Management section.
3. Select the Copy Files subsection of File Management.
4. Select the Copy Configuration radio button, select Running Configuration from the Source drop-down menu, and select Startup Configuration from the Destination drop-down menu.
5. Click Activate to initiate the process.

Setting up the Dell EqualLogic PS6100XV storage

1. Using the command-line console, via serial cable, connect to the Dell EqualLogic PS6100XV array, and power cycle it to access the initial setup.
2. Supply a group name, group IP address, and IP address for eth0 on the array.
3. After group creation, using a computer connected to the same subnet as the storage, use the Dell EqualLogic Web interface to do the following:
   a. Click Start→Internet Explorer, and enter the IP address of the Dell EqualLogic PS Series Group Manager. For our testing, we used 192.10.1.100.
   b. Log into the Group Manager using the factory default credentials.
   c. Expand Members, click the member Storage, and, in the right pane, select the Network tab.
   d. Right-click eth0, and select Modify IP settings.
   e. Enter the desired IP address for the second iSCSI connection, and click OK. For our testing, we used 192.10.1.101 for the IP address and 255.255.255.0 for the Subnet mask.
   f. Right-click eth0, and select Enable interface.
   g. Repeat steps b through d for the remaining iSCSI NIC (eth1, eth2, and eth3), and apply the appropriate IP address and subnet mask. For our testing, we used 192.10.1.102-192.10.104 for the IP addresses, and 255.255.255.0 for the subnet mask. Verify MTU size of 9,000 on each NIC.
4. To create a storage pool, right-click Storage pools, and select Create storage pool (select RAID 10).
5. Create volumes:
   a. In the left pane, click Volumes, and, in the adjacent pane, click Create volume.
   b. Name the volume VirtualMachine1 and click Next.
c. Type 70 for the Volume size, and click Next. For our testing purposes, we did not create a snapshot reserve with the volume.

d. On the Step 3 – iSCSI Access screen, click the Allow simultaneous connections from initiators with different IQN names checkbox. Review the Summary, and click Finish.

6. Repeat step 5 seven times for the remaining volumes, using the following names and Volume sizes:
   - VirtualMachine2 – 70GB
   - VirtualMachine3 – 70GB
   - SharePoint – 250GB
   - Exchange – 500GB
   - ExchangeLog – 100GB
   - SQLData – 250GB
   - SQLLog – 50GB
APPENDIX C - CONFIGURING THE ESXi HOST SERVERS

Configuring vSphere 5 (ESXi) after installation

1. On the ESXi screen, press F2, enter the root password, and press Enter.
2. On the System Customization screen, select Configure Management Network.
4. On the IP Configuration screen, select set static IP, enter an IP address and subnet mask, and press Enter.
5. On the Configure Management Network screen, press Esc. When asked if you want to apply the changes, type Y.
6. Complete steps 1 through 5 for the other host server.

Installing the Dell EqualLogic Multipathing Extension Module (MEM) version 1.1 Beta on the ESXi servers

1. Using a file transfer utility, copy the MEM installation ZIP file to each ESXi server.
2. Use the following command to install the Dell EqualLogic MEM beta. Consult the installation and user guide for more details on the VMware MEM integration.
   esxcli software vib install -d membundlename.zip --no-sig-check
3. Using the Dell EqualLogic Multipathing Extension Module Installation and User Guide, verify that the MEM is functional on each server.
APPENDIX D - CREATING AND CONFIGURING A CLUSTER

Installing vSphere Client

You can install vSphere Client on any Windows-based system for accessibility. For this setup, we installed it on the management server.

1. Insert the vCenter Server 5 DVD.
2. Select Autorun.
3. Select vSphere Client from the list of VMware Product Installers, and click Install.
4. Select English, and click OK.
5. At the Welcome screen, click Next.
6. Click Next to accept the End-User Patent Agreement.
7. Accept the License Agreement, and click Next.
8. Enter the User Name and Organization information, and click Next.
9. Accept the default destination folders, and click Next.
10. At the Ready to Install screen, click Install.
11. Click Finish when installation completes.

Creating a cluster using the vSphere Client

1. Using the vSphere client just installed, connect to the vCenter Server on the management server.
2. Right-click the Service Center, select New Datacenter, and enter a name.
3. Right-click the New Datacenter, and select New Cluster.
4. Enter a name for the cluster in Cluster Features screen, and check the box next to Turn On vSphere HA.
5. Accept the default settings for vSphere HA, and click Next.
6. Select VM and Application Monitoring from the VM Monitoring drop-down menu, and click Next.
7. Select Enable EVC for Intel Hosts, and click Next.
8. Accept the recommended swapfile policy, and click Next.
9. Review the settings in the Ready to Complete screen, and click Finish.
10. Right-click the cluster, and click Add Host.
11. Enter the Host IP address and administrative account credentials for the host, and click Next.
12. At the security alert, click Yes.
13. Review the Host information, and click Next.
14. Enter a license key, and click Next.
15. Do not enable lockdown mode, and click Next.
16. Accept the default location for the host’s virtual machines, and click Next.
17. Review the summary, and click Finish.
18. Repeat steps 2 through 17 to add the second ESXi host to the cluster.
APPENDIX E - CONFIGURING THE STORAGE

Configuring the Dell EqualLogic PS6100XV for access from the host servers

1. Log into vSphere Client.
2. Select the first ESXi host in vSphere Client.
3. Click on the Configuration tab of this host.
4. Select Storage Adapters from the Hardware section of the left panel.
5. Click on the iSCSI Software Adapter, and copy the iSCSI name listed in the Details pane into a blank notepad or word processing document.

Copying the iSCSI names of the ESXi hosts into a blank notepad document allows you to have these names readily available for step 9c below.

6. Repeat steps 2 through 5 for the second ESXi host.
7. Click Start→Internet Explorer, and enter the IP address of the Dell EqualLogic PS Series Group Manager.
8. Log into the Group Manager using the credentials you created during the Remote Setup Wizard.
9. Select the first volume listed in the EqualLogic Storage Manager, and complete the following steps. For our test configuration, this was VirtualMachine1.
   a. Click the Access tab.
   b. Click Add.
   c. Select Limit access to iSCSI initiator name, and paste the initiator name of the first ESXi host into the field.
   d. Click OK.
   e. Repeat steps b through d for the second ESXi host.
10. Repeat step 9 seven times for the remaining volumes:
   - VirtualMachine2
   - VirtualMachine3
   - SharePoint
   - Exchange
   - ExchangeLog
   - SQLData
   - SQLLog

Configuring the external volumes in VMware vSphere 5

1. In the vSphere client, select the first host.
2. Click the Configuration tab.
3. Click Storage, and click Add Storage...
4. Choose Disk/LUN.
5. Select the disk, and click Next.
6. Accept the default of VMFS-5 for the file system.
7. Review the disk layout, and click Next.
8. Enter the datastore name, and click Next.
9. Accept the default of using maximum capacity, and click Next.
10. Click Finish.
11. Repeat steps 3 through 10 for the remaining LUNs.
APPENDIX F - CONFIGURING NETWORKING

Configuring VM networking on ESXi

1. Using vSphere client connect to vCenter Server on the management server, and perform the following steps on each host server in the cluster.
   2. Add the necessary vSwitch for the VM/Public network:
      a. Click the host, click the Configuration tab, and click Networking.
      b. Click Add Networking.
      c. Choose Virtual Machine, and click Next.
      d. Choose VMkernel, and click Next.
      e. Choose create a vSphere standard switch.
      f. Choose the NIC associated with VM traffic.
      g. Assign the network label and assign IP settings.
      h. Click Finish.

Configuring the vMotion network

1. Using vSphere client, connect to vCenter Server on the management server, and perform the following steps on each host server in the cluster.
   2. Add the necessary vSwitch for the network that vMotion traffic will use:
      a. Click the host, click the Configuration tab, and click Networking.
      b. Click Add Networking.
      c. Choose VMkernel, and click Next.
      d. Choose create a vSphere standard switch.
      e. Choose the NIC associated with vMotion traffic, and click Next.
      f. Assign the network label, and check the box Use this port group for vMotion.
      g. Click Next.
      h. Assign IP settings, and click Next.
      i. Click Finish.

Configuring iSCSI networking on ESXi

1. Using vSphere client, connect to vCenter Server on the management server, and browse to the two servers in the cluster. Perform the steps that follow on each server in the cluster.
   2. Add the necessary vSwitches:
      a. Click the host, click the Configuration tab, and click Networking.
      b. Click Add Networking.
      c. Choose VMkernel, and click Next.
      d. Choose create a vSphere standard switch.
      e. Choose the first onboard gNIC associated with iSCSI traffic.
      f. Assign the network label, and assign IP settings.
      g. Click Finish.
      h. Repeat steps b through g for the remaining NIC assigned to iSCSI traffic.
   3. Add the iSCSI software storage adapter:
      a. Click the host, click the Configuration tab, and click Storage adapters.
b. Click Add.
c. Click Add software iSCSI adapter.
d. Click OK.

4. Configure the iSCSI software storage adapter:
   a. Right-click the iSCSI adapter that was just added to the system, select Properties, and ensure it is enabled.
   b. Inside the iSCSI adapter Properties window, click the Network Configuration tab.
   c. Under VMkernel port bindings, click Add, and add each VMkernel adapter to the VMkernel port bindings list.
   d. Close the iSCSI Initiator Properties window and allow a rescan of the host bus adapter by clicking Yes.

5. Enable jumbo frames in ESXi:
   a. Click the host, click the Configuration tab, and click Networking.
   b. On the first vSwitch used for iSCSI, click Properties.
   c. Select the vSwitch.
   d. Click Edit.
   e. Modify the MTU to 9,000.
   f. Click OK.
   g. In the vSwitch Properties window, choose the VMkernel port.
   h. Click Edit.
   i. Modify the MTU to 9,000.
   j. Click OK.
   k. Click Yes if warned about datastore access.
   l. Click Close.
   m. Repeat steps b through l the remaining NIC dedicated to iSCSI traffic.

6. Access provisioned Dell EqualLogic storage:
   a. In the vSphere client, click the host, click the Configuration tab, and click Storage adapters.
   b. Right-click the iSCSI software storage adapter, and select Properties.
   c. Click the Dynamic discovery tab.
   d. Click Add.
   e. Enter the Dell EqualLogic group IP address.
   f. Click OK.
   g. Click Close.
   h. Click Yes when prompted to rescan the HBA.
APPENDIX G - CONFIGURING THE DELL MANAGEMENT VCENTER PLUG-IN

1. Download the Dell Management vCenter Plugin (a self-extracting EXE), and extract the files.
2. Log onto the ESXi host with vSphere Client, and click on File→Deploy OVF Template.
3. Browse to the OVF file extracted to the Dell Management vCenter plugin folder, and click Open.
4. Review the OVF Template Details, and click Next.
5. Review the Name and Location, and click Next.
6. Select the destination storage for the virtual machine files, and click Next.
7. Select Thin Provision, and click Next.
8. Review the Ready to Complete window, and click Finish.
9. When the appliance has been successfully imported, power it on.

When you first start the CentOS based appliance, it will reboot one time, then prompt you to set the admin password. Once the password is set, you will see a link to the Admin Portal in the form of https://<IP Address>/DellAdminPortal/index.html, along with options for configuring network settings, time zones, and other appliance management tasks.

10. Open a browser, and connect to the appliance by entering the link described above.
11. Log in with the password you set previously.
12. Click on VCENTER REGISTRATION on the left side, and click on the Register New vCenter Server link.
13. Enter the IP address and administrator credentials for the vCenter Server that contains the 12G Dell hosts you wish to manage. This registers the plugin with vCenter Server.
14. Reboot the host.
15. Once the host is rebooted, you can now access the plugin from the VirtualCenter Home page.

The first time you launch the Management Plugin, a wizard will guide you through the steps to create a Connection Profile.

16. Click Next at the Configuration Wizard Welcome page.
17. Click Create New at the Connection Profiles page.
18. Enter a profile name, and click Next.
19. Select the associated hosts for the connection profile, and click Next.
20. Enter the credentials of the iDRAC for the host you are configuring, and click Next.
21. Enter the credentials of the OMSA agent, and click Next.
22. Click the Test Selected button on the Test Connection Profile page to test the iDRAC and OMSA Agent.
23. Enter the credentials for the iDRAC of the server and the ESXi host.

At this point, you will also be asked when to run Inventory and Warranty Status jobs. You can also force the jobs to Run Now under Job Queue from the left panel.
APPENDIX H - CREATING THE VIRTUAL MACHINES

Creating the VMs

1. In vSphere client, connect to the vCenter Server on the management server, and browse to one of the ESXi hosts.
2. Click the Virtual Machines tab.
4. Choose Custom, and click Next.
5. Assign a name to the virtual machine, and click Next.
6. Select the first assigned OS Datastore on the external storage, and click Next.
7. Select Windows → Microsoft Windows Server 2008 R2 (64-bit), and click Next.
8. Click 1 for the number of NICs, select vmxnet3, and click Next.
9. Make the OS virtual disk size the maximum available, select thick-provisioned lazy zeroed, and click Next.
10. Select Edit the virtual machine settings before completion, and click Continue.
11. Choose two virtual processors, and click Next.
12. Choose 4GB RAM, and click Next.
13. Select the iSCSI controller, choose VMware Paravirtual, and click OK twice.
14. Click Finish.
15. Repeat steps 1 through 14 to create two more VMs.
16. Attach the Windows Server 2008 R2 SP1 ISO image to the VM, and install Windows Server 2008 R2 on your first VM.

Installing the operating system on the VMs

Complete these steps on each VM.

1. Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive, and attach the physical DVD drive to the VM. Alternatively, use an ISO image and connect to the ISO image from the VM console.
2. Open the VM console on vSphere.
3. At the Language Selection Screen, click Next.
4. Click Install Now.
5. Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
6. Click the I accept the license terms check box, and click Next.
7. Click Custom.
8. Click Next.
9. At the User’s password must be changed before logging on warning screen, click OK.
10. Enter the desired password for the administrator in both fields, and click the arrow to continue.
11. At the Your password has been changed screen, click OK.
12. Install the latest VMware Tools package on the VM. Restart as necessary.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname, and reboot when the installation prompts you.
16. Set up networking:
   a. Click Start → Control Panel, right-click Network Connections, and choose Open.
   b. Right-click the VM traffic NIC, and choose Properties.
c. Select TCP/IP (v4), and choose Properties.
d. Set the IP address, subnet, gateway, and DNS server for the virtual NIC, which will handle outgoing server traffic. Click OK, and click Close.

17. Repeat steps 1 through 16 to install the operating system on the other two VMs.

Adding the external volumes to the VMs in VMware vSphere 5

1. In the vSphere client, right-click the first VM.
2. Click Edit Settings.
3. Select the Hardware tab, and click Add...
4. Choose Hard Disk from the Device Type list, and click Next.
5. Choose Create a new virtual disk, and click Next.
6. Select Specify a datastore or datastore cluster, and click Browse...
7. Select the datastore from the list, noting the maximum capacity, and click OK.
8. Change the Disk Size to the maximum capacity, noted in step 7, and click Next.
9. Select SCSI (1:0) from the Virtual Device Node drop-down box, and click Next.
10. Review the Ready to Complete summary, and click Finish.
11. Repeat steps 1 through 10 for the remaining volumes.
12. In the VM, add the iSCSI storage:
   a. Start the VM, and click the Server Manager icon in the taskbar.
   b. In the left pane, expand Storage, and click Disk Management.
   c. Right-click the first volume, and choose Online.
   d. Right-click the first volume, and choose Initialize Disk.
   e. Select MBR (Master boot Record) for the partition style, and click OK.
   f. In the right pane, right-click the volume, and choose New Simple Volume...
   g. At the Welcome screen, click Next.
   h. At the Specify Volume Size screen, leave the default selection, and click Next.
   i. At the Assign Drive Letter or Path screen, choose a drive letter, and click Next.
   j. At the Format Partition screen, leave the default selection, and click Next.
   k. At the Completing the New Simple Volume Wizard screen, click Finish.
   l. Repeat steps c through k for the remaining VM volumes.
13. Repeat steps 1-12 for the remaining VMs, and attach the appropriate volumes.
APPENDIX I - CONFIGURING THE VIRTUAL MACHINES

Installing SQL Server 2008 R2 on VM #1

Install an instance of Microsoft SQL Server 2008 R2 by following these steps. This installation walkthrough covers only the installation of the Database Engine and Management Components. For other components outside the scope of this guide, such as Reporting Services, Integration Services, or Analysis Services, see Microsoft documentation at http://msdn.microsoft.com/en-us/library/ms143219(SQL.105).aspx.

1. Connect to vCenter Server with vSphere client, and power on the VM.
2. Log into the virtual machine.
3. Insert the installation DVD for SQL Server 2008 R2 into the appropriate ESXi host server’s DVD drive.
4. Using the VM menu, click the connect/disconnect button for the CD/DVD driver, and select connect to D:, where D: is the letter of the physical server’s DVD drive.
5. Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2008 R2 DVD, and double-click.
6. If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core role.
7. At the SQL Server Installation Center screen, click Installation. Click New installation or add features to an existing installation.
8. At the Setup Support Rules screen, click OK.
9. At the Product Key screen, enter your licensing information, if applicable, and click Next.
10. At the License Terms screen, accept the license terms, and click Next.
11. At the Setup Support Files screen, click Install.
12. At the Setup Support Rules screen, click Next.
13. At the Setup Role screen, choose SQL Server Feature Installation, and click Next.
14. At the SQL Server 2008 R2 Feature Selection screen, select the features that your organization requires. We chose the following features for this guide: Database Engine Services, Client Tools Connectivity, Client Tools Backwards Compatibility, Management Tools – Basic, Management Tools – Complete, and Full Text Search. Click Next.
15. At the Installation Rules screen, click Next.
16. At the Instance Configuration, enter the appropriate details for your configuration. For a default instance, leave the defaults selected. For a named instance, enter a new instance name and adjust the file paths as necessary.
17. At the Disk Space Requirements screen, click Next.
18. At the Server Configuration screen, choose the service account, preferably an Active Directory domain account, fill in a password if necessary, and click Next.
19. At the Database Engine Configuration screen, choose an authentication mode. If your legacy servers use SQL Server logins at all, select Mixed Mode. If you exclusively use Active Directory domain accounts in your SQL Server environment, choose Windows Authentication.
20. If you choose to use Mixed Mode authentication, enter a password for the system administrator (SA) account, click Add Current User, and click Next.
21. At the Error Reporting screen, click Next.
22. At the Installation Configuration Rules screen, click Next.
23. At the Installation screen, click Install.
24. At the Complete screen, click Close.
25. After the SQL Server 2008 R2 installation process completes, check Microsoft’s Web site for the latest SQL Server service pack, and install any available service packs.
Installing Exchange Server 2010 SP2 on VM #2

Installing the prerequisites

Install .NET Framework 3.5.1 features, Internet Information Services, the Microsoft Filter Pack 2.0, enable RSAT-ADDS, and enable the Net.Tcp Port Sharing service.

1. Select Start ➔ Administrative Tools ➔ Server Manager.
2. Click Features.
3. Click Add Features.
4. Select .NET Framework 3.5.1 Features.
5. Click Add Required Role Services.
6. Click Next.
7. Click Next.
8. At the Select Role Services screen, select the IIS 6 Metabase Compatibility, IIS 6 Management Console, Basic Authentication, Windows Authentication, Digest Authentication, Static content compression, and Dynamic content Compression checkboxes, and click Next.
9. At the Confirm Installation Selections screen, click Install.
10. At the Installation Results screen, click Close.
12. Run FilterPackx64.EXE.
13. Click Next.
14. Click I accept the terms in the License Agreement, and click Next.
15. When the installation is complete, click OK.
16. Click Start, type services and press Enter.
17. Right-click the Net.Tcp Port Sharing service, and click Properties.
18. Change the Net.Tcp Port Sharing startup type to Automatic, and click OK.
19. Open a command prompt, type ServerManagerCmd –i RSAT-ADDS and press Enter.
20. Reboot the VM.

Installing Exchange Server 2010 SP1

1. Insert the installation DVD, capture the host DVD drive to VM2, and click Setup.EXE when the installation prompts you.
2. The installer should consider steps 1 and 2 complete, and gray them out.
3. Click the link to Step 3: Choose Exchange Language Option.
4. Click Install only languages from the DVD.
5. Click the link to Step 4: Install Microsoft Exchange Server 2010 SP1.
6. Click Next to go past the introduction screen.
7. Accept the license agreement, and click Next.
8. Select No for error reporting, and click Next.
10. Leave the organization name at default (First Organization), and click Next.
11. At the question about client computers running Outlook 2003 and earlier, select the appropriate option for your environment, and click Next.
12. Configure your external domain access, or click Next to accept defaults for the Configure Client Access Server external domain screen.
13. At the Customer Experience Improvement Program screen, select I don’t want to join the program at this time, and click Next.
14. If a warning about a lack of SMTP appears after the check finishes, ignore it for now. We will address this in the following section.
15. Click Install to start the installation process.
16. Once installation is complete, click Finish.
17. Click OK when the installation prompts you to reboot.
18. Click Close.
19. Click Yes to confirm exit.
20. Reboot the VM.

Configuring Exchange Server 2010 roles

2. In the left pane, click Microsoft Exchange On-Premises.
3. In the left pane, expand Organization Configuration, and select Hub Transport.
4. In the action pane on the far right, select New Send Connector.
5. Name the send connector SMTP select the intended use as Internet, and click Next.
6. In the Address space window, click Add.
7. In the SMTP Address Space window, type * as the address, ensure that Include all subdomains is selected, and click OK.
8. Click Next.
9. On the Network settings page, select Use domain name system (DNS) “MX” records to route mail automatically, and click Next.
10. Accept the defaults in the Source Server window, and click Next.
11. At the New Connector page, click New to create the connector.
12. Click Finish to close the New SMTP Send Connector wizard.

Installing SP2 for Microsoft Exchange 2010

2. Double-click the downloaded file to extract the installation files.
3. Click OK to accept the destination directory for the extracted files.
4. Double-click setup.exe to launch the installer.
5. Click Install Microsoft Exchange Server upgrade.
6. At the Introduction screen, click Next.
7. Accept the terms in the license agreement, and click Next. The Readiness Checks will now run.
8. Install any roles in Server Manager that the Readiness Checks prompt you to install.
9. When the checks successfully complete, click Upgrade.
10. Click Finish, and reboot.

Moving the location of a mailbox database

2. In the left pane, expand Organization Configuration, and click Mailbox.
3. Select the mailbox database you wish to move, and in the far right pane, click Move Databases.
4. Modify the Database file and Log folder path locations to their new desired locations, and click Move.
5. If the application prompts you to dismount, click Yes.
6. Click Finish.
Installing SharePoint Server 2010 on VM #3

1. Insert the installation DVD, and capture the DVD drive in the VM session.
2. Launch setup.exe, and click Install software prerequisites.
3. At the Welcome to the Microsoft SharePoint 2010 Products Preparation Tool screen, click Next.
4. Accept the EULA, and click Next.
5. When the prerequisites finish installing, click Finish.
6. On the main SharePoint installation menu, click Install SharePoint Server.
7. Enter your product license key, and click Continue.
8. Accept the EULA, and click Continue.
9. Choose the Stand-Alone server type, and click Install.
10. When the installation finishes, check the box for Run the SharePoint Products Configuration Wizard now, and click Close.
11. On the Welcome to SharePoint Products screen, click Next.
12. On the pop-up warning about services that will need to be restarted during the configuration, click Yes.
13. When the wizard has completed the configuration, click Finish.
ABOUT PRINCIPLED TECHNOLOGIES

We provide industry-leading technology assessment and fact-based marketing services. We bring to every assignment extensive experience with and expertise in all aspects of technology testing and analysis, from researching new technologies, to developing new methodologies, to testing with existing and new tools.

When the assessment is complete, we know how to present the results to a broad range of target audiences. We provide our clients with the materials they need, from market-focused data to use in their own collateral to custom sales aids, such as test reports, performance assessments, and white papers. Every document reflects the results of our trusted independent analysis.

We provide customized services that focus on our clients’ individual requirements. Whether the technology involves hardware, software, Web sites, or services, we offer the experience, expertise, and tools to help our clients assess how it will fare against its competition, its performance, its market readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked together in technology assessment for over 20 years. As journalists, they published over a thousand articles on a wide array of technology subjects. They created and led the Ziff-Davis Benchmark Operation, which developed such industry-standard benchmarks as Ziff Davis Media’s Winstone and WebBench. They founded and led eTesting Labs, and after the acquisition of that company by Lionbridge Technologies were the head and CTO of VeriTest.